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TimeOut Graph™ is part of the TimeOut AppleWorks™ 
enhancement series. All of the products in this series work inside of 
AppleWorks and are easily selected from a single menu. 

With TimeOut Graph you can create a wide variety of business 
charts and professional graphs from your AppleWorks Spreadsheet 
and Data Base data. 

Because Timeout Graph is integrated with AppleWorks, you can 
graph your spreadsheets fast. It's easy. Just highlight the 
spreadsheet data and choose the type of graph you want and 
TimeOut Graph does the rest, instantly drawing your graph on the 
screen; all without leaving AppleWorks. Compare this to other 
graph programs where you must save your files, quit Apple Works, 
then transfer your data to another program. 

TimeOut Graph offers several graph types including Bar, Line, Pie, 
XY (Scatter), Stacked Bar, Area, Hi-Lo, Exploded Pie, and Point. 
There are also a number of enhancement options that let you fine
tune your graphs by adding titles, labels, legends, and grid lines to 
namea few. 

Once you've created a graph, you can print it in a variety of sizes on 
most dot-matrix printers, directly from inside AppleWorks. 

About this Manual 

This manual is divided into three main sections: Installing 
TimeOut, Graph Tutorial, and Graph Reference. 

If you have not already installed TimeOut on your Apple Works 
STARTUP disk, you will need to read all of chapter 2 "Installing 
TimeOut". If Timeout is already installed, read only the section 
called Copying Applications to the Timeout Application Disk on 
page 9. 



After installing TimeOut Graph, you can read the Tutorial section 
which leads you through the process of creating several sample 
graphs, or you can go directly to the Reference Section which 
describes each TimeOut Graph feature in detail. 

If you're not already familiar with the AppleWorks Spreadsheet, 
you may want to refer to the AppleWorks Tutorial and Reference 
Manuals before starting. 

Note: This manual assumes that you are familiar with 
AppleWorks and the AppleWorks method of doing things (e.g. 
selecting menu options, answering questions, loading files, 
escaping, etc.) If you're not, then refer to the appropriate 
sections of your AppleWorks manuals. 
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TimeOut Graph is provided on both 5.25-inch and 3.5-inch disks. 
Before using your Timeout Graph disk, please take a moment to 
make a backup copy of the disks you will be using. Since the disks 
are not copy-protected, you may use any standard disk duplication 
program such as Filer, System Utilities, Copy II Plus, or Beagle 
Bros' Timeout FileMaster. Be sure to write-protect and safely store 
your original disk so you don't accidentally overwrite it. (Use the 
backup copy when using TimeOut Graph). Please do this now. 

Beagle Bros software isn't copy-protected. That makes it easier for 
you to use and easier to make backup copies. Please support us in our 
commitment to supply friendly, easy-to-use software by not giving 
away copies to your friends. 

Timeout Compatibility 

TimeOut is the controlling program that modifies AppleWorks and 
makes it possible for you to use applications like TimeOut Graph 
from inside AppleWorks. TimeOut applications are actually 
integrated into the AppleWorks environment, unlike other 
AppleWorks enhancements you may be familiar with. This 
revolutionary advancement makes them more powerful, faster and 
easier-to-use. 

TimeOut is compatible with AppleWorks versions 2.0 and later. If 
you have an earlier version, contact your dealer about getting an 
update from Apple. You must also have the USA version. TimeOut 
does not work with foreign language versions of Apple Works. 

TimeOut is compatible with most enhancements to AppleWorks 
including Super MacroWorks, AutoWorks, Applied Engineering's 
desktop expander, Checkmate's desktop expander, and the 
Pinpoint accessories. 

If you are installing TimeOut with other AppleWorks 
enhancements, we recommend that you install TimeOut last. The 
only exception is if you are also using the Pinpoint desktop 
accessories. Always install Pinpoint last. 



Installation 

Once your backup copy has been made, boot your Timeout Graph 
disk by placing it in your boot drive and turning your computer off 
and back on or by pressing Control-Open-Apple-Reset. 

Soon the title screen will appear. The menu contains three options: 

1. Update AppleWorks 

2. Read NOTES 

3. Quit 

Select Read NOTES. This will inform you of any changes to 
TimeOut Graph that have been made since this instruction manual 
was printed. 

After you have read the NOTES, you will return back to the 
TimeOut startup screen. This time select Update Apple Works. 

Sorting the Timeout Menu 

You must now specify whether or not you would like TimeOut to sort 
the list of TimeOut applications in the TimeOut menu. The names 
will be sorted alphabetically if you specify Yes. Otherwise, they 
will appear in the same order as they do in the disk catalog. By 
specifying No, you decide the order of the names in the TimeOut 
menu by placing them on your TimeOut applications disk in the 
order that you want. 

Installing Timeout 7 
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Location of Timeout Applications 

The next step is to indicate where TimeOut should look for the 
TimeOut applications. All of the TimeOut applications must be 
placed on the same disk. This can be a hard disk, a RAM disk, a 
floppy disk, or any ProDOS disk device. (See Copying 
Applications to the Timeout Application disk on page 9.) The 
choices you have are: 

1. AppleWorks STARTUP disk 

2. Slot and Drive 

3. ProDOS directory 

The simplest approach is to place the TimeOut applications on 
your Apple Works STARTUP disk. By doing that, you never have 
to search for a separate TimeOut applications disk. If you have a 
hard disk or a 3.5-inch disk, you can place them in the same 
directory or subdirectory with your AppleWorks STARTUP 
program (APL WORKS.SYSTEM). 

If you have more than one disk drive, you may want to dedicate one 
drive to your TimeOut applications. You may specify either Slot 
and Drive or ProDOS directory to indicate where the TimeOut 
applications disk will be. For more information on ProDOS 
directories, see the section in your AppleWorks manual called 
ProDOS, prefix for filenames. 

Location of AppleWorks 

The next step is to indicate where your AppleWorks STARTUP 
program is so TimeOut can be installed. You may specify either 
Slot and Drive or ProDOS directory. After indicating the 
location of AppleWorks, press a key and your Apple Works 
STARTUP program will be updated with TimeOut. 

Note: This is a one time modification. If you add more Timeout 
applications later, you don't need to modify Apple Works 
again. 



Re-installing Timeout 

After you have already installed TimeOut, if you need to change 
the applications disk location or the order of the menu, you can re
install TimeOut by following the same steps for initial 
installation. This will only work if you have not installed any 
other AppleWorks enhancement programs since you installed 
TimeOut. If you have then you may need to completely reconfigure 
Apple Works. 

Copying Applications to the Timeout 
Application Disk 

If you are using other TimeOut applications, you will need to copy 
Graph to your TimeOut applications disk. Otherwise, you have 
the option of using the TimeOut Graph disk as your TimeOut 
applications disk or any other disk (i.e. the AppleWorks Startup 
disk, a RAM disk, or a hard disk). 

If you need to copy the applications to another disk, you can use any 
standard file copy program such as the Filer, System Utilities, 
Copy II Plus, or File Master. You will need to copy the following 
files: 

TO.GRAPH 

TO. UTILITIES 

TO.CLIPBOARD 

Note: You may not need to copy the file TO.UTILITIES or 
TO.CLIPBOARD if they're already on your Timeout 
application disk. 

Installing Timeout 9 
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Starting up AppleWorks with Timeout 

When you start up Apple Works with TimeOut installed, you 
should see the TimeOut title screen before you reach the 
Apple Works main menu. TimeOut will scan your TimeOut 
applications disk looking for TimeOut applications. 

File: None 

Loading: 

Graph 
Uti lities 

GE'.ITIN8 STARTED 

TI!£CUT Integrated AfpleW:>rks Afplications 

Copyright 1987, by Alan Bird 

(version 1.0) 

Press Escape to cancel loading applications into meno:ry 1029K Avail. 

Note: If you receive a message indicating that Timeout is 
getting errors trying to load the Timeout applications, it means 
that Timeout is unable to find the applications. At this point 
you must insert your applications disk if you have not already 
done so. If you have inserted your applications disk and are 
still getting errors, you either do not have any applications on 
the disk or your disk has been damaged. You will need to create 
a new applications disk. 

If you do not see a Timeout title screen, you have not installed 
Timeout correctly. Go back to page 5 and start over. 



As TimeOut identifies each TimeOut application, they are listed 
on the screen. An asterisk (''*") before the application name 
indicates that it is memory-based. You may press Escape at any 
time to prevent memory-based applications from loading into 
memory (see pages 61, 62 for an explanation of memory-based 
applications). This doesn't affect your ability to use them, it just 
makes them disk-based. 

Accessing Timeout Applications 

While you are using Apple Works, you may call up the TimeOut 
menu at any time by holding down the Open-Apple key and 
simultaneously pressing the Escape key. A menu similar to the 
following will appear (you may have fewer or more applications 
than this): 

Tilte<:Xlt Menu 

1. FilEMo!ster 
2. Graph 
3. Quick.Spell 
4. SideSpread 
5. SuperFonts 
6. UltraM3cros 
7. Utilities 

Use the up and down arrow keys or type a number to select an 
application, then press Return (press Escape if you don't want to 
make a selection). If your applications are not memory-based, be 
sure your TimeOut applications disk is in the drive when you press 
Return. Otherwise, you will be prompted to insert your TimeOut 
application disk. 

Installing Timeout 11 
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Memory usage 

You will notice with TimeOut installed that you have less desktop 
memory for your Apple Works documents. TimeOut itself takes up 
some of the memory. Graphics applications and memory hungry 
applications (like Graph) will take up an additional 8K of 
memory. 

Memory-resident TimeOut applications also take up desktop 
memory. If you are short on desktop memory, reconfigure your 
applications so they are disk-based. 

However, for maximum speed, make your TimeOut applications 
memory-based or run them from a RAM disk. If your computer has 
more than 128K of memory, we highly recommend that you 
configure TimeOut Graph as a memory-resident application. This 
will improve the speed when graphing. 

Control-Reset Patch 

When you install TimeOut on your Apple Works Startup disk, 
TimeOut makes a patch to AppleWorks so that Control-Reset will 
take you to the Main Menu instead of the machine-language 
monitor. 
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The following section of the manual is devoted to a step-by-step 
tutorial that leads you through the process of creating several 
sample graphs. This section includes three lessons: Graphing a 
Sample Spreadsheet, Enhanced Pie Graphs, and XY Graphs and 
Linear Regression. 

We recommend that first time AppleWorks users carefully read 
this section. Advanced users may want to just browse through the 
lessons, noting the various samples, then read the Reference 
Section. 

Lesson 1: Graphing a Sample Spreadsheet 

If you haven't already started Apple Works, do so now. Load the 
sample file Bicycle Company from the Timeout Graph disk. 

The spreadsheet looks like this: 

File : Bicycle carpany REVIEW/J\DD/OWG: Escape : Main Manu 
=== 0PF=== = B===C=== -'~F'r=-==IF=-=Q==oo= 

1 1 
2 1 'Ihe Bi cycle carpany 
3 11986 Sales by DEpartrrent 
4 1 
51 
6 IDEpartrrent 1st 2nd 3rd 4th 
71 
81Bikes 42 68 20 92 
9 1 Accessories 29 43 38 59 

10 I Safet y Geer 12 18 15 22 
111 ClothinJ 21 31 25 41 
12 1 
13 1Total 104 160 98 214 
141 
151 
161 
171 
181 

Al 

Type en..!!:l'... or use A cx:mranc:S A- ? for help 



This file shows The Bicycle Company sales for each department 
(bikes, accessories, safety gear, and clothing) over a period of four 
quarters. 

There are several informative graphs that can be made from this 
data. For now, suppose that you want to make a bar graph showing 
the bike sales for all four quarters. Using TimeOut Graph, this task 
is simple. 

Starting Timeout Graph 

To start TimeOut Graph, you must select Graph from the TimeOut 
menu. Press OPEN APPLE-ESC to bring up the menu, then select 
Graph from the list of applications. If Graph doesn't appear in the 
menu, see Installation on page 7. 

The Graph main menu will appear at the bottom of the screen with 
the Type option highlighted. 

Timeout GRAPH Vl.O Copyright 1987, Rob Renstrom 

Graph? Type Data View Options File Reset Print 

From this menu you can quickly access every TimeOut Graph feature 
with just a few, simple keystrokes. 

Selecting the Graph Type 

You must first choose the type of graph you want to make. For this 
example you want a bar graph. 

1. Select the highlighted Type option by pressing RETURN. 

The Type menu appears, replacing the Graph menu. 

Type? Bar Line Pie XY Stacked-Bar Area Hi-Lo 

Graph Tutorial 15 
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This menu offers seven graph types. Several variations of these 
types are available, such as Exploded Pie graphs, by using 
options explained in the Reference Section. 

2. Since Bar is already highlighted, press RETURN to select it. 

TimeOut Graph will return to the Graph main menu. 

Selecting the Graph Data 

Next, you need to tell TimeOut Graph which spreadsheet values 
you want to use in creating the graph. For now, you want to graph 
the bike sales in each quarter. 

1. From the Graph main menu, select Data. 

The Data menu replaces the Graph menu. 

Data? X A B C D E F 

This menu allows you to select as many as six data ranges, A 
through F. A data range is simply a group of numbers in the 
spreadsheet that will be used to create the graph. This can be 
any group of cells in the spreadsheet: a partial row or column, or a 
block of cells. 

To graph the Bike sales, you want to choose cells B8 through E8: 

2. Select A to choose the first data range. 

The following prompt appears at the bottom of the screen, 
replacing the Data menu. 

A Range 
Move cursor to beginning of data range and press 
Return 

3. Move the spreadsheet's cursor to the cell B8, the number of bikes 
sold in the first quarter, then press RETURN. This cell becomes 
the start of the data range. 



TimeOut Graph then asks you to: 

Use cursor moves to highlight data range, then 
press Return 

4. Press the RIGHT ARROW key three times to highlight the 
remaining numbers. 

With the data range highlighted, cells BS through ES, your 
screen looks like this: 

File: Bicycle carpany SEIECT IWG: Escape: Select Fange Start 
~~=====PF============IB=======O======D==========E F G===== 

11 
21 The Bicycle carpany 
311986 Sales by Departrrent 
41 
51 
61Departrrent 1st 
71 

2rrl 3rd 4th 

SI Bikes 42 68 20 92 
91Accessaries 29 

10 I Safety Gear 12 
lllClothirg 21 
121 
131 Quarter Tutals 104 
141 
151 
161 
171 
181 

E8: (Value) 92 
A Fange 

43 
18 
31 

160 

38 
15 
25 

98 

59 
22 
41 

214 

Use cursor moves to highlight data range, then press Feturn 

If your screen looks different, press ESC to go back one step, then 
re-select the data range. 

5. To accept the highlighted range, press RETURN. 

6. Then press ESC to return to the Graph main menu. 

Graph Tutorial 17 
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Viewing the Graph 

So far you have used two simple options to select the graph type 
and the data you want to graph. The final step is to display the 
graph. 

Choose the View option and TimeOut Graph will instantly draw 
the graph on the screen. Notice that the vertical axis (y-axis) is 
automatically scaled to the numbers that were chosen. 

When you're through admiring your first graph, press the SPACE 
bar to continue. 

100 
90 
80 
70 
60 
so 
40 
30 
20 

r111111,11111111'11111 ;i 

10 
o.W!.@~71!LJ..._J~~iliL_lli~~~~W4tl~ 

Enhancing the Graph 

To complete this graph you can add titles, labels, and a variety of 
other items that will enhance its appearance. 



Adding a Graph Title 

1. Choose Options from the Graph main menu. 

A new menu will appear: 

Options? Legend Titles Format Grid Scale 

The Options menu allows you to taylor various aspects of the 
graph's appearance, such as adding Legends, Titles, or Grid lines. 

Since you want to add a title: 

2. Choose Titles by pressing T. 

The Titles menu appears. 

Titles? Main Sub X-Axis Y-Axis 

This menu allows you to add a title above the graph (Main and 
Sub), below the X-Axis, and along the Y-Axis. 

3. Choose Main. 

TimeOut Graph asks you to enter the main graph title: 

Type the main title: 

4.TypeTHE BICYCLE COMPANY 

5. Press RETURN. 

To add a second title, below the first. 

6. Choose Sub. 

7. Type 198 6 Sales by Quarter, then press RETURN. 

8. Press ESC once to return to the Options menu, then once more to go 
back to the Graph main menu. 

Graph Tutorial 19 
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Adding Axis Labels 

You may also add labels along the horizontal axis (or x-axis) that 
identify each bar in the graph. These labels are entered by 
pointing to a range of cells in the spreadsheet, just as you did when 
you selected the first data range. 

Since you want the Quarters to appear along the axis, you need to 
select the cells containing 1st, 2nd, 3rd and 4th. 

1. Select the Data option. 

2. Select x to specify the X Range. 

Unlike the A through F ranges that are used to select data for the 
graph, the X range is used to select labels for the x-axis. TimeOut 
Graph uses the contents of the cells in this range as labels. 

3. Move the cursor to cell B6, then press RETURN. 

4. Press the RIGHT ARROW key three times to highlight the 
other quarters. 

5. To accept the highlighted range, press RETURN. 

6. Press ESC to go back to the Graph main menu. 

To see the modified graph, select View. 



Notice that TimeOut Graph automatically centers the title 
above the graph and the labels along the x-axis. 

100 
90 
80 
70 
60 
50 
40 
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1st 

THE BICYCLE COMPANY 
1986 Sales by Quart er 

2nd 3rd 

When you're ready to continue, press the SPACE bar. 

Re-Graphing Spreadsheet Changes 

4th 

One of the most powerful features of TimeOut Graph is the ability 
to quickly redraw any changes made to your spreadsheets. 

For instance, suppose that the number for the third quarter bike 
sales is incorrect. The correct amount should be 60. Using the 
spreadsheet you can change this number, then instantly redraw a 
new graph, reflecting this change (without having to re-select the 
data range). 

1. From the Graph main menu, press ESC to leave TimeOut Graph 
and return to the spreadsheet. 

2. Move the cursor to cell DB, the third quarter bike sales. 

Graph Tutorial 21 
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3. Type 60. 

4. Press RETURN. 

5. Press OPEN APPLE-ESC to bring up the TimeOut menu and then 
press RETURN to select Graph, which is already highlighted. 

6. Type v to select the View option. 

TimeOut Graph redraws the graph, using the new amount in the 
third quarter. Notice that TimeOut Graph remembered the data 
range, labels, and titles you selected previously, using them to 
create the new graph. Because of this feature, you can redraw a 
graph immediately after making a change to the spreadsheet. 

Compare this process to stand-alone graphics packages where the 
you must save your spreadsheet, exit AppleWorks, start another 
program, transfer the data, then finally draw the changed graph. 

Changing Graph Types 

Before going on to some of the other options, let's see how easy it is 
to view the same data as a different type of graph. This is another 
significant feature of TimeOut Graph. 

To view the data as a Line chart: 

1. If you haven't already done so, press the SPACE bar to return to 
the Graph main menu. · 

2. Type T L v to select Type, Line, and View. 

The Line chart shows trends better than Bar charts. From this 
chart, you can see that the sales trend for The Bicycle Company is 
definitely heading up! 

3. Press the SP ACE bar to go back to the Graph menu. 



100 

90 
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50 

THE BICYCLE COMPANY 
1986 Sales by Quarter 

2nd 3rd 

To see the data as a Pie Chart: 

1. Type T P v to select Type, Pie, and View. 

4th 

This Pie chart shows the percentage of the bike sales in each 
quarter. TimeOut Graph automatically calculates the percent for 
each data item based on the total of all the items. As you can see, 
more than a third of the bike sales occurred in the forth quarter. 

2. Press the SPACE bar. 

3. Type T B to select bar graphs again. 
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4th (35,1/.) 

THE BICYCLE COMPANY 
1986 Sales by Quarter 

3rd (22.9i0 

Adding More Data Ranges 

2nd <26.o;o 

You can make a more complex graph by including the sales data for 
the other departments. This is done by defining a separate data 
range for each department. Since you have already chosen one data 
range, the bike sales, you must start with the second data range, 
Range B. 

1. Type D to select the Data option. 

2. Choose range B, by typing B 

Highlight the Accessories sales: 

3. Move the cursor to the beginning of the second data range, cell B9, 
then press RETURN. 

4. Press the RIGHT ARROW key three times to highlight the 
other cells. 

5. Press RETURN to accept the highlighted range. 

The other two ranges are defined in the same manner. 



6. Select c from the menu and highlight cells BIO through ElO. 

7. Select D from the menu and highlight cells Bll through Ell. 

After defining the data ranges, press ESC to return to the Graph 
menu, then select View to see the new graph. 

100 
90 
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60 
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40 
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THE BICYCLE COMPANY 
1986 Sales by Quarter 

2nd 3rd 4th 

You'll notice that the bars now have four different patterns, 
representing the four data ranges. And that each group of bars 
corresponds to the data items in each range. For instance, the first 
group of bars correspond to the first data item in each range, the 
second group corresponds to the second item in each range, and so on. 
This makes it easy to compare the different ranges. 

Graph Tutorial 25 



26 Chapter3 

Adding Legends 

Since the bars now have more than one pattern, you should identify 
the category each pattern represents. In this case the patterns 
represent the different departments: Bikes, Accessories, Clothing, 
and Safety Gear. 

1. Select Options from the Graph menu. 

2. Type L to select Legend. 

3. Type A to enter the legend for range A. 

TimeOut Graph asks you to enter the legend for the first data 
range: 

Type legend for A range: _ 

4. Type Bikes 

5. Press RETURN. 

Enter the legends for the other ranges as follows: Accessories as 
the B range; Safety Gear as the C range; Clothing as the D 
range. 

After you enter the legends, press ESC to return to the Options menu. 

Adding Grid Lines 

Grid lines can make a graph easier to read. To add grid lines to the 
sample bar graph: 

1. Select Grid from the Options menu. 

The Grid menu appears, with the default Clear option 
highlighted. 

Grid? Horizontal Vertical Both Clear 



2. Type H to add horizontal grid lines over the graph. 

The Vertical option adds vertical lines; Both adds both 
horizontal and vertical lines; Clear removes any grid lines. 

3. Press ESC to return to the Graph menu. 

To see the enhanced graph, select View from the Graph menu. 

100 
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2nd 3rd 4th 

~Bikes II Rccessories [ii Safety Gear []Clothing 

Press the SP ACE bar to go back to the Graph menu. 

More Graph Types 

Now that the sample graph has more than one data range, you can 
take a look at two of the other graph types. 

To see the data as an Area graph: 

l. Type T A v to select Type, Area, and View. 
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The Area graph is similar to the stacked bar graph, showing the 
total of the items and the contribution of each item. But, like the 
line graph, it shows the trend of the data. 

2. Press the SPACE bar. 

To view the data as a Stacked Bar graph: 

1. Type T S v to select Type, Stacked Bar, and View. 

lst 

THE BICYCLE COMPANY 
1986 Sales by Quarter 

2nd 3rd 4th 

~Bikes ll!lllccessories G]Saf'ety Gear fill Clothing 

The Stacked Bar graph stacks the bars on top of each other, 
showing the total of the items in each range. From this graph 
you can easily see the total sales for each quarter and the 
contribution of each department to the total. 

2. Press the SP ACE bar to go back to the Graph menu. 



Saving Graph Settings 

You already know that if you exit TirneOut Graph and return to the 
Spreadsheet, TimeOut Graph will remember any options or data 
ranges you have chosen, allowing you to switch between TimeOut 
Graph and the Spreadsheet without reselecting these graph 
settings. However, if you want to create a different graph of 
another spreadsheet file, or leave AppleWorks, these settings will 
be lost. That is, they will be lost, unless you save them. 

Just as you save your spreadsheet files before leaving AppleWorks, 
you need to save the graph settings. By saving the settings, you can 
later recall them to create the same graph without reselecting the 
data ranges or any other options. The File option lets you save and 
load graph settings. 

1. Select File from the Graph main menu. 

The File menu appears. 

File? Graph Settings Pie 

These two options allow you to save and load graph settings or 
pictures. 

The Graph Settings option saves any TirneOut Graph options 
you have chosen: data ranges, titles, legends, labels, grid lines, 
etc. 

The P ic option allows you to save a graph as a picture file for use 
with another program, or load a background picture for the 
graph. 

2. Type G to select Graph Settings. 

The Graph Settings menu will appear. 

Graph Settings? Save Load 
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3. Choose Save. 

TimeOut Graph will ask you to type the filename for saving the 
settings. 

Type filename: Bicycle Comp.GF_ 

TimeOut Graph offers a suggested filename. You can either 
accept the suggested filename or you can type your own. GF in the 
suggested name stands for Graph File. 

4. Press RETURN to accept the filename. 

The graph settings will be saved on the AppleWorks current data 
disk. 

Printing Graphs 

As you have probably guessed by now, the Print option lets you 
print your graphs. Before you can use this option, you need to 
configure TimeOut Graph for your printer and printer interface 
card. If you haven't already done this, see Appendix B. 

To print the last graph displayed with the View option: 

1. Select Print from the Graph menu. 

The Print menu appears, showing one or more Size options. 

Print? Size 1 Size 2 Size 3 

Make sure your printer is turned on and ready to go. 

2. Select the first size option, Size 1. 

TimeOut Graph will start printing the graph. If the graph doesn't 
print properly, see "Printer Problems" in Appendix B. 



Leaving Timeout Graph 

To exit TimeOut Graph, and return to the Spreadsheet: 

l. Press ESC from the Graph main menu. 

You can re-enter TimeOut Graph anytime, by pressing OPEN 
APPLE-ESC to call up the TimeOut menu, then select Graph. 

What's Next 

You've now learned the basics of using TimeOut Graph: choosing 
menu options, defining data ranges, entering information, adding 
enhancements, creating different graph types, saving graph 
settings, and printing graphs. 

With what you've learned, you can start making you own graphs, 
using the Reference Section as a guide; or you can go on to the next 
two lessons. 
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Lesson 2: Enhanced Pie Graphs 

This lesson shows you how to create a Pie graph with shaded and 
exploded slices that let you emphasize one or more of the slices. 

Load the Computer Sales file. 

File : Conputer Sales REVIEW/ ADD/CHAN:;E Escape : Mlin M2nu 
===/lr====~D==E F=G== 

11 
2 IMiddle'Ibwn Crnputer Shep - July Crnputer Sales 
31 
41 
5 IJ>pple IIGS 27 
6 IM>cintosh 23 
7 ll'pple Ile 16 
8 IJ>ppl e Ile 12 
91 

101 
111 
121 
131 
14 1 
151 
161 
17 1 
181 

Al 

Type entry or use A crnrnands A- ? for Help 

This file shows the number of Apple computers sold by the 
MiddleTown Computer Shop in July. From this data, you can create 
a Pie graph that shows the percent of sales for each computer. 

Resetting Graph Settings 

Before you can begin, you need to clear out any previous graph 
settings from the last graph. 

1. If you're not already in TimeOut Graph, press OPEN APPLE-ESC 
to bring up the TimeOut Menu. Then select Graph. 



2. Select Reset from the Graph main menu. 

The Reset menu appears. 

Reset? X A B C D E F Graph 

3. Select Graph to clear the previous graph settings. 

Making a Simple Pie Graph 

To create a pie graph showing the percent sales of each computer: 

l. Select Type and then choose Pie as the graph type. 

From the Data menu: 

2. Choose A and define cells BS through B8 as the A range. These 
are the values for the pie slices. 

3. Choose x and define cells AS through A8 as the X range. The 
contents of these cells will appear as the labels next to each slice. 

4. Press ESC to return to the Graph main menu. Then select View to 
create the graph. 
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Apple IIGS C34.6Xl 

Apple Ile <20.5:1.) 

Macintosh <29.rn 

S. Press the SPACE bar to go back to the Graph menu. 

Shading Pie Graphs 

You can enhance the appearance of this graph by shading one or 
more of the pie slices. Use data range B to indicate the shading for 
each slice. This range can be any block in the spreadsheet that is 
the same size as the A range. The value of each cell in the B range 
determines the shading pattern for the corresponding pie slice in 
the A range. 

Here's how to add shading: 

1. From the Graph main menu, press ESC to return to the 
spreadsheet. 

2. Enter the following numbers in cells CS through CS: 11, 8, 9, and 
10. 

These numbers are the shading patterns that will be used for the 
corresponding pie values in cells BS through BS. 



3. Press OPEN APPLE-ESC to bring up the TimeOut Menu. Then 
select Graph to re-enter Graph. 

4. From the Data menu, choose B and define cells CS through C8 as 
the B range. This tells TimeOut Graph to use these values as the 
shading pattern numbers. 

5. Press ESC to return to the Graph main menu. Then select View to 
see the new pie graph. 

Hpple Ile (20 .s:o 

Macintosh <29.5:0 

6. Press the SP ACE bar to go back to the Graph menu. 

Exploding Pie Graphs 

You can also create exploded pie graphs that have one or more of 
the slices shifted away from the center of the pie. You indicate 
that you want an exploded slice by adding 100 to the pattern value 
that corresponds to the slice. For example, try changing the value 
in cell CS to 111(that's11+100) and see what you get. 
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Lesson 3: XV Graphs and Linear Regression 

This lesson gives an advanced example of how to create an XY 
graph with a linear regression line that can be used to predict data 
values. 

If Linear Regression doesn't sound interesting to you, just skip this 
lesson and go on to the Reference Section. 

XY graphs are commonly used to show the relationship, if any, 
between two sets of data, like age and income, high school grades 
and college grades, advertising and sales, etc. Linear regression 
allows you to determine if there is a linear correlation between two 
data sets. If there is a correlation, you can use the regression line to 
predict one value based on the other. 

Load the sample file Regression from the TimeOut Graph disk. 

File: Regression REVIEW/.ADD/CHAN:;E Escape : M3in Manu 
A &=====C==D=E F==G======H=I= 

11 Linear Regression using M;!thod of I.east Squares 
21 
31 n= 7 sun(x*y)= 2991 a= - 2 . 57 
41 sum(x)= 64 sun(xA2)= 680 b= 4.64 
51 sum(y)= 279 sun(yA2)= 13417 r= .94 
61 
71 
81 Ads Sales 
9 1 x y x*y XA2 yA2 Best Fit 

101 
111 4 15 60 16 225 15.99 
121 5 17 85 25 289 20 .63 
131 7 39 273 49 1521 29 .91 
141 10 33 330 100 1089 43.83 
15) 11 52 572 121 2704 48.47 
161 12 58 696 144 3364 53.11 
171 15 65 975 225 4225 67.03 
181 

Al: (Label) Line;ir Fe 

Type entry or use A ccmnands A-? for Help 

This spreadsheet shows the number of advertisements and 
corresponding sales for a seven month period. These are the x and y 



data values in columns A and B. The first month, for example, had 
4 ads and 15 unit sales. 

The other values in the spreadsheet are statistical functions 
calculated from the x and y values. These are used to produce the 
regression line that best fits the data. The most important of these 
values is the correlation coefficient (referred to as r), which 
represents the mathematical relationship between the two sets of 
data. The value of the correlation coefficient is always between -1 
and 1. When this value is close to -1 or l, it indicates a high 
correlation (or linear relationship) between the data sets. A value 
close to 0 indicates that there is not a linear relationship. Notice 
that this data has a very high correlation coefficient of .94, which 
indicates a linear relationship between ads and sales. 

To create an XY graph of this data and the regression line: 

1. Press OPEN APPLE-ESC to bring up the TimeOut Menu. Select 
Graph. 

2. Choose Reset from the Graph main menu. From the Reset menu, 
select Graph to clear the previous graph settings. 

3. Select Type and then choose XY as the graph type. 

4. From the Data menu: choose x and define cells All through Al7 
as the X range; choose A and define cells Bll through Bl7 as the A 
range; choose B and define cells 111 through 117 as the B range. 

Unlike the other graph types, XY graphs require at least two 
data ranges, one for the x values, and one (or more) for they 
values. This is the only graph type that actually plots the cells 
in X range as values; the other graph types use the cells in X 
range as labels for the x-axis. 

In this example, data ranges A and B, the y values, are plotted 
against range X, the x values. Data range B is the regression line. 

5. Press ESC to go back to the Graph menu, then select Options. 

6. Select Grid from the Options menu, then select Both to add both 
horizontal and vertical grid lines. 
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7. Select Format from the Options menu. From the format menu, 
select A, then select Symbols to format range A as symbols only. 

The Format option allows you to choose whether you want each 
data point plotted with connecting lines, or with symbols only. 

8. Press ESC twice to return to the Graph main menu. 

7. Choose View to create the graph. 

70..----....~--.-~.....--.-~.....---.~~~~--....~--.-~ 

60 +----1--'""----1----l.--1-----1--1----l----l---"::l..l,,.-1-----I v 
S0+--+~+--+~+-~~-+-~1b"'.--~~+--+-----I y 
40 .j....._-J.----l--1.L.--Lp-.J...,C::.....J-_..J._.J..__.J__..J.____J 

30 +--+--+----""'.C:.....-1~-I--+ ~~-l---+--+---1----1 
~ 20+-~'---t-~t---+~+---t~-+-~t--+~-t---i r' I0...._--+~--1-~1---i...~-1-~~__._~._--+~-+----J 
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The x-axis shows the number of advertisements and the y-axis 
show the number of sales. The symbols are plotted at each x,y data 
point according to the data values. From the regression line, you 
can predict one value based on the other. For instance, if there are 9 
ads, there would be about 40 unit sales. 

You may use this spreadsheet as a tempJate to perform regression 
analysis on your own data. 
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This section contains reference information that describes every 
TimeOut Graph feature in detail. 

Creating a Graph 

Perform these steps to create a graph: 

1. Select the spreadsheet data you want to graph by defining one or 
more Data Ranges. 

2. Choose the type of graph you want. 

3. Enhance the graph with titles, labels, legends, etc. 

4. View or Print the graph. 

5. Save the Graph Settings. 

Defining Data Ranges 

Before you can create a graph, you must tell TimeOut Graph which 
spreadsheet cells contain the data you want to graph. This is done 
by defining data ranges. 

A data range is a continuous series of cells in the spreadsheet, 
either a group of cells from a row or a column, or a block of cells. 

TimeOut Graph can plot up to six data ranges, A, B, C, D, E, and F; 
each may contain as many cells as you wish, giving you the 
capability to graph a virtually unlimited number of data values. 

The X range specifies the labels that appear along the horizontal 
axis or x-axis, except with Pie and XY graphs. With Pie graphs, 
the X range specifies the labels that appear beside each pie slice. 



The XY graph is the only graph type that doesn't use the X range as 
labels; it uses the X range as data. 

Defining a Data Range 

To define a group of cells in the spreadsheet as a data range: 

1. Use the Data option to select the range you want to define, X, A, 
B, C, D, E, or F. 

2. Move the cursor to the starting cell in the range, then press 
RETURN. 

3. Using the arrow keys, highlight the cells in the range. 

4. Press RETURN to accept the highlighted range. 

5. Choose another range or press ESC to back to the Graph main 
menu. 

Recalling a Selected Range 

If you select a range that has already been defined, it will appear 
highlighted in the spreadsheet. 

You can accept the previous range by pressing RETURN. 

Or, you can change the previous range by using the arrow keys to 
highlight a new ending cell. To select a new starting cell, press ESC 
once, then start with step 2 above. 
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Selecting a Graph Type 

TimeOut Graph offers seven basic types of graphs. In addition, 
several variations of these types are available, such as Exploded 
Pie Graphs. 

Use the Type option to select the type of graph you want. 

Bar Graphs 
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Travel 

Bar graphs typically show the value of an item over a period of 
time, or compare the values of different items. 

Data ranges A through F specify the values that are used to create 
the graph. If you select more than one range, the bars will appear 
in groups; each group shows one value from the selected ranges at 
each interval. (The number of bars in a group is equal to the number 
of data ranges you have defined.) This allows easy comparisons 
between the values in the data ranges. 



With more than one range, the bars are shaded with different 
patterns to distinguish between the ranges. You may want to add a 
legend that identifies each range with its pattern. See the Legend 

option. If you don't like the patterns TimeOut Graph assigns to the 
ranges, you may select a different set of patterns. See 
"Configuration Options" in Appendix B for details. 

Range X specifies the labels that appear at each interval on the 
horizontal axis or x-axis. 

Graph Tip: If you have a lot of data items, switch to a line 
graph, or create a series of separate graphs that show just a few 
items at a time. If you try to cram too much information into a 
single graph, it will look overcrowded and make it more 
difficult to understand. This simple rule applies to the other 
graph types as well. 

Graph Reference 43 



44 Chapter4 

Line Graphs 
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The line graph is ideal for presenting large amounts of data in a 
format that allows you to quickly determine trends and 
relationships. 

Data ranges A through F specify the values that are used to 
produce the graph. Each range is plotted with a separate line. If 
you choose more than one range, you may want to use the Format 
option to add symbols at each data point to distinguish the 
separate lines. Use the Legend option to identify the symbols in 
the graph. If you wish to change the symbols used in the graph, see 
"Configuration Options" in Appendix B. 

Range X specifies the labels that appear along the horizontal x
axis. 

With the Format option you can select three variations of the 
standard line chart. You can choose to have the data points shown 
with connecting lines (creating a line chart); with symbols (a point 
chart); or with both lines and symbols. 



XV Graphs 
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XY graphs (also known as scatter plots) show relationships and 
correlations between data. They can also be used to plot 
mathematical functions. 

The y values, from data ranges A through F, are plotted against the 
x values, from range X. This is the only graph type that actually 
plots the cells in the X range as values; the other graph types use 
the cells in the X range as labels for the x-axis. You must define a 
minimum of two data ranges: range X, for the x values, and at least 
one other range, A, B, C, D, E or F, for they values. 

TimeOut Graph will plot the data points with connecting lines, 
unless you use the Format option to select point symbols, or a 
combination of lines and symbols. 

Graph Tip: If you connect the data points with lines, use the 
AppleWorks arrange command to sort the X or Y values in 
ascending order. This will prevent overlapping lines in the 
graph. 
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Pie Graphs 
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Pie graphs show the relative percentages of parts that make up the 
whole. Each slice in the pie represents its portion of the total. 

Data range A specifies the values that are used for the pie slices. 
Unlike the other graph types, the pie graph can only represent one 
data range. The number of slices in the pie is equal to the number of 
cells in this range. Negative values in the data range will not be 
plotted. 

The X range specifies the labels that appear next to each pie slice. 
TimeOut Graph automatically calculates the percentage of each 
value based on the total of all the values and places the percentage 
along side each label. 

TimeOut Graph will also create Exploded/Shaded Pie graphs that 
let you emphasize one or more pie segments. 

Data range B indicates whether the segments should be shaded 
and/ or exploded. This range can be any block in the spreadsheet 
that is the same size as the A range. The value of each cell in the B 



range determines the shading pattern for the corresponding pie 
segment in the A range. See Appendix A for the pattern values. 
Adding 100 to the pattern value will make an exploded slice. 

Graph Tip: Usually, pie graphs should have less than ten 
slices to prevent overcrowding. If you have more than ten 
values, try combining some of the smaller values in an "Other" 
or "Miscellaneous" category. You may also want to create a 
second pie chart that shows the breakdown of this combined 
category. 

Stacked Bar Graphs 
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The stacked bar graph shows each values relative contribution to 
the total. The values from each data range are stacked on top of 
values from the previous range, making it easy to see the total of 
the ranges and how much each value contributes to the total. 

Data ranges A through F specify the values used to create the 
graph. Of course, you would only use this graph type if you have 
two or more data ranges to stack. 
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As with bar graphs, you may want to add a legend to identify the 
bar patterns in the graph. 

Range X specifies the labels that appear below the horizontal axis 
at each interval. 

Area Graphs 
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The area graph is a line version of the stacked-bar graph. It shows 
each values relative contribution to the total, while making it easy 
to determine trends. The values from each data range are added to 
values from the previous range. 

Data ranges A through F specify the values used to create the 
graph. 

The area between the lines is shaded with a different pattern to 
distinguish the ranges. Use the Legend option to identify the 
patterns in the graph. To select a different set of patterns, see 
"Configuration Options" in Appendix B. 



Range X specifies the labels that appear below the horizontal axis 
at each interval. 

Hi-Lo Graphs 
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The Hi-Lo graph is sometimes called the Hi-Lo-Open-Close graph, 
because it is frequently used to graph stock market data. It shows 
the difference between a high value and a low value. Each high
low value is plotted with a connecting vertical line. 

You must define both the A and B ranges. Data range A specifies 
the high values. Data range B specifies the low values. Each 
value in the B range must be less than the corresponding value in 
the A range; otherwise, the value will not be plotted. 

Data ranges C through F specify any values between the high and 
low values. These will appear as point symbols on the hi-lo lines. 
Any data values outside the hi-lo range are not plotted. 

Use the Legend option to identify the symbols in the graph. 
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Range X specifies the labels that appear along the horizontal x
axis. 

Viewing a Graph 

Once you have defined the data range(s) and selected a graph type, 
you can view the graph with the View option. 

Re-Graphing Spreadsheet Changes 

One of the most powerful features of TimeOut Graph is the ability 
to quickly redraw any changes made to your spreadsheets. You can 
exit TimeOut Graph, modify your spreadsheet, then return to 
Graph and use the View option to instantly redraw a new graph, 
reflecting the changes. 

Printing a Graph 

TimeOut Graph can print your graphs in several sizes on most dot
matrix printers. If you haven't already configured TimeOut Graph 
for your printer and interface, see "Configuration Options" in 
Appendix B. 

The Print option will print the last graph that was displayed 
with the View option. 

When you select the Print option, a menu of print sizes will 
appear: 

Print? Size 1 Size 2 Size 3 

The number of sizes will vary depending on your printer. Some 
printers may only have one size, while others have many. The 
actual printed sizes also vary depending on the printer. Size 1 is 



the smallest, Size 2 is the next smallest, and so on. Try each Size 
option to determine the actual sizes with your printer. 

After choosing a size, TimeOut Graph will start printing the 
graph. 

If the graph does not print correctly or if nothing happens, make 
sure that you have configured TimeOut Graph for the correct 
printer and interface, and that your printer is powered-on and 
selected. 

While the graph is printing you may press ESC to stop printing and 
return to the menu, or the SP ACE bar to pause. 

NOTE: Every effort has been made to provide print sizes that 
accurately display the proportions of the graph as shown on 
the screen (ie., a pie chart appears as a perfect circle); 
however, this· is not possible with a few of the printers. 

Saving and Loading Graph Settings 

Graph settings are any options you've chosen to create a graph, such 
as data ranges, titles, legends, labels, grid lines, scale formats, etc. 
These settings can be saved on disk and later recalled to produce the 
same graph without reselecting the options. 

When using recalled graph settings, you must make sure that you're 
using the same spreadsheet file that was used when you saved the 
settings; otherwise, the data ranges may not point to the correct 
cells in the spreadsheet. 

Here's how to save and load the graph settings: 

1. Select Fi le from the Graph main menu. 

2. Select Graph Settings. 

From the Graph Settings menu: 
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3. Choose Save or Load 

TimeOut Graph will ask you to enter the name of the file that 
will be used to save or load the settings. A suggested filename is 
offered. 

4. You can accept the suggested name by pressing RETURN. Or, you 
can enter a different file name, then press RETURN. 

If you choose Save, the graph settings will be saved in the 
specified file at the current disk location. The current location is 
usually your AppleWorks data disk, unless you specify a different 
location. 

If you choose Load, the graph settings will be loaded from the 
current disk location. Be sure to load the corresponding spreadsheet 
file, otherwise the graph settings are useless. 

Clearing Graph Settings 

Use the Reset option to clear the previous graph options you've 
selected. You can reset all the graph settings, or just selected data 
ranges. 

From the Reset menu: 

Select Graph to reset all the graph settings. 

Select x, A, B, c, D, E or F to reset the corresponding range; 
you may then select another range, or press ESC to return the Graph 
main menu. 



Saving and Loading Graph Pictures 

TimeOut Graph lets you save your graphs as pictures for use with 
other programs, such as Triple-Dump, Beagle Graphics, Dazzle 
Draw, and TimeOut SuperFonts. The graphs are saved as standard 
double hi-res files. You can also load double hi-res pictures into 
TimeOut Graph to be used as backgrounds for the graphs. 

Here's how to save and load graphs as pictures: 

1. Select File from the Graph main menu. 

2. Select P ic. 

From the Pie menu: 

3. Choose Save or Load 

TimeOut Graph will ask you to type the name of the file that 
will be used to save or load the graph picture. If you previously 
entered a filename, TimeOut Graph will supply this name as a 
default. 

4. Press RETURN if you want to use the default name. Or type a 
new filename, then press RETURN. 

If you choose Save, the last graph that was plotted will be saved 
in the specified file at the current disk location. The current 
location is usually your AppleWorks data disk, unless you specify a 
different location with the AppleWorks "Change current disk 
drive or ProDOS prefix" option. 

If you choose Load, the picture file you specify will be loaded from 
the current disk location. You won't see the picture, until you select 
the View option. The graph will then be plotted on top of the 
picture. 

NOTE: Background pictures may cause problems with the 
pattern shading in Area and Pie graphs. 
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Graphs in Word Processor Documents 

With TimeOut SuperFonts, another program in the TimeOut series, 
you can print your AppleWorks Word Processor documents in a wide 
variety of high-quality Macintosh fonts and mix text with 
pictures. This allows you to print saved graphs inside your word 
processor documents. 

Titles 

You may add up to two titles above the graph, one below the x-axis, 
and one along the y-axis. To add titles: 

1. Select Titles from the Options menu. 

2. Select Main or Sub if you want to add a title above the graph; x
Axis to add a title below the x-axis; or Y-Axis to add a title 
along the y-axis. 

TimeOut Graph will ask you to type a title. 

3. You may press RETURN to accept the previous title. Or type a 
new title and press RETURN. Remember that you can use 
DELETE and CONTROL-Y to edit the previous title. 

4. Select another title, or press ESC to return to the Options menu. 

Try to keep your titles short and informative. You don't need to use 
axes titles if the units of measurement or labels along each axis are 
self-explanatory (or explained in the main or sub title). 



Legends 

Use legends to identify the shading patterns used in Bar and Area 
graphs, or the symbols used in Line and XY graph. You may add a 
legend for each data range you have defined. To add legends: 

1. Select Legend from the Options menu. 

2. Choose a data range, A through F. 

TimeOut Graph asks you to enter the legend for the data range. 

3. Press RETURN to accept the previous legend. Or type a new 
legend and press RETURN. 

4. Select another range, or press ESC to return to the Options menu. 

Formatting Lines and Symbols 

With Line and XY graphs you can choose whether you want lines 
and/or symbols. You may choose lines and symbols for each data 
range or the entire graph (all ranges). Here's how: 

1. Select Format from the Options menu. 

2. Choose the range you want to format A through F, or choose 
Graph to format all ranges. 

TimeOut Graph will offer three options. 

3. Select Lines to connect the plotted data points with lines, 
Symbols to plot a symbol at each data point, or Both to add both 
lines and symbols. 

4. Select another range, or press ESC to return to the Options menu. 
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Grid Lines 

Grid lines can be added to make a graph easier to read. You may 
add both horizontal and vertical grid lines. To add grid lines: 

1. Select Grid from the Options menu. 

2. Select Horizontal to add horizontal grid lines, Vertical to 
add vertical lines, Both to add both horizontal and vertical line, 
or Clear if you don't want any lines. 

3. Press ESC to return to the Graph menu. 

Changing the Scale 

Timeout Graph automatically sets the scale (the upper and lower 
limits, and the increment) to fit the data in your graphs. This 
feature makes it easy to quickly create graphs. However, in some 
cases you may want a different scale than the one chosen by 
TimeOut Graph. 

Manual Scaling 

Here's how to select manual scaling: 

1. From the Options menu, select Scale. 

The Scale menu gives you the choice of changing the scale for the 
x and y axes, and setting the skip factor for the x-axis labels. The 
X Scale option applies only to XY graphs. 

2. Choose Y Scale or x Scale. 



TimeOut Graph will offer the following options: 

Automatic is the default setting; TimeOut Graph will 
automatically adjust the scale to fit the data. (You'll notice 
that, unlike a lot of other graphing programs, TimeOut Graph 
always picks nice numbers when automatic scaling is turned on.) 

Manual selects manual scaling. 

Format lets you specify the format of the numbers that appear 
along each axis. See "Formatting Scale Numbers." 

3. Choose Manual then select the Upper, Lower, and Increment 
options to set the maximum scale value, the minimum scale value, 
and the scale increment. 

If you set the scale limits too low or high for your data, TimeOut 
Graph will show as much of the data as possible; lines and bars 
may be clipped to fit within the graph space. 

Formatting Scale Numbers 

The Format options lets you specify the following formats for the 
numbers that appear along each axis: 

Fixed: Sets a fixed number of decimal places, 0-7. 

Dollars: Same as commas except with a dollar sign before each 
amount. 

Commas: Sets a fixed number of decimal places, 0-7; provides 
commas between thousands; negative amounts are in parentheses. 

Percent: Displays the numbers with a percent sign and a fixed 
number of decimal places, 0-7. This format multiplies the scale 
numbers by 100. 

Appropriate: This is the default setting. Decimal places are 
displayed as necessary, without trailing zeros. 
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Skipping Scale Increments 

The Skip option tells TimeOut Graph to use only every nth cell in 
the X data range for the labels along the x-axis. This prevents the 
labels from overlapping if you have a lot of labels, or if the labels 
are exceptionally long. A skip factor of 2 will skip every other 
label, which is usually sufficient to avoid overlapping. 
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Timeout Utilities 
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The TimeOut Utilities application is provided with all TimeOut 
products. It has several functions that give you a lot more 
flexibility in using your TimeOut applications. 

Using the Utilities 

To use the TimeOut Utilities, make sure that the file 
TO.UTILITIES has been copied to your TimeOut applications disk. 
Start up AppleWorks and press Open-Apple-Escape to call up the 
TimeOut menu. Select Utilities. You will see the following 
screen: 

File : TimeOut Doc UTILITIF.S Escape : Molin Manu 

TiITE<Xlt awlications utility opticns 

1. Configure 

2. load to manory 

3. Dunp fran memory 

4 • Charx:ie rnemory status 

5 • Change narre 

6. Sort menu 

TimeOut utilities Copyright 1987, by AL3n Bird (Version 1.0) 

Tyi:e nunber, or use arrows , then press Return 1027K Avail. 

Configure 

The Configure option allows you to set new defaults for your 
TimeOut applications. Configurable options might include printer 
type, default font, location of files needed by the application, etc. 
Not all TimeOut applications have configurable options. 



To configure an application, select Configure from the Utilities 
menu. Then select the application you want to configure. You will 
then see a menu indicating what options may be configured for that 
particular application. You should also see the current value for 
each option in brackets [ ]. 

Select an option that you would like to change. Enter or select the 
new value for that option. Make sure that the TimeOut 
applications disk is in a drive so that the application can be 
updated with the new value. The next time you use the 
application, it will use the new value that you have supplied. 

After you are finished updating configurable options, press Escape 
to return to the Utilities main menu. 

Load to memory 

TimeOut applications are either disk-resident or memory-resident. 
If an application was configured as disk-resident when you started 
up Apple Works, you can load it into memory using the Load to 

memory option. Just select the option from the Utilities menu and 
select which application you would like to load. 

Dump from memory 

If you receive a message from AppleWorks indicating that it was 
unable to complete an option because of insufficient desktop 
memory, you may need to dump one or more TimeOut applications 
that are memory-resident. Select Dump from memory from the 
Utilities menu and select which application you would like to 
dump. Notice that the amount of free memory indicated in the 
lower right hand portion of the screen increases with each 
application you dump. Applications that are dumped are returned 
to disk-resident status for the remainder of the AppleWorks 
session. 
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Change memory status 

This option allows you to indicate whether a TimeOut application 
is disk- or memory-resident. Note that this only indicates how the 
application will be treated when you start up AppleWorks. To 
load an application into memory or to return it to the disk for the 
current AppleWorks session, you will need to use the Load to 
memory option or the Dump from memory option. 

Change name 

This option allows you to change the name of the application as it 
appears in the TimeOut menu. The Beagle Bros staff carefully 
selects a good name for each application. However, you have the 
flexibility of renaming it if you wish. 

If the new name you enter is longer than the old name, the name 
change will not be reflected in the TimeOut menu until the next 
time you start up Apple Works. 

Sort Menu 

When you apply TimeOut to your AppleWorks STARTUP disk, you 
are given the option of indicating whether or not you want the 
TimeOut menu automatically sorted by application name. If you 
choose not to have the menu sorted, you can still sort it after 
starting up AppleWorks by selecting Sort menu from the Utilities 
menu. 
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Configuration Options 

Configuring Graph 

Use the TimeOut Utilities application (see Appendix A), to select 
the following configuration options. 

Printer 

The Printer option will display a list of printers supported by 
TimeOut Graph. If your printer is not listed, check to see if it's 
compatible with one of listed printers, or try a few of the more 
common printers, such as EPSON FX or APPLE IMAGEWRITER. If 
none of these work, contact Beagle Bros Technical Support for 
assistance. 

Interface 

This option will display a list of the supported printer interface 
cards. If your interface is not listed, try APPLE PARALLEL or 
APPLE SUPER SERIAL. 
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Interface Slot Number 

This is the slot number for your interface card, usually slot 1. If you 
are using the Apple I I c or Apple IIGS serial port, set the slot to 1. 

Needs Line Feed after Return 

This option indicates whether or not your printer needs a line feed 
after every carriage return. This should be set to Yes for most 
printers, however, you may want to refer to your printer manual. 

Pattern Order 

These options indicate the shading patterns that are used in the 
Bar, Stacked-Bar, and Area graphs. The order of the patterns, 1 
through 6, corresponds to data ranges A through F. You can enter 
any of the following pattern numbers: 

D•~~~~!Zn~llCillHEl lil OIIIIIl~mm 
0 l 2 3 4 5 6 7 8 9 10 11 12 13 14 15 



Symbol Order 

These options indicate the symbols that are used in Line, XY, and 
Hi-Lo graphs. Symbols 1 through 6 correspond to data ranges A 
through F. Symbols 7 and 8 apply only to Hi-Lo graphs. They are 
used as the high and low symbols. You can enter any of the 
following symbol numbers: 

a + 0 A v x T ~ a + * + I • ~ 

0 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

Graph Box 

The Graph Box option specifies whether you want a box drawn 
around your graphs, in addition to the x and y axes. 
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Printer Problems 

If you are unable to print a graph, make sure that you have 
configured TimeOut Graph for the correct printer, interface, and 
interface slot number. If nothing happens when you print, make 
sure the printer is powered-on and selected (on-line). If you are 
still unable to print, contact Beagle Bros Technical Support for 
assistance. 
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Data Converter 

The TimeOut Data Converter allows you to quickly and easily 
transfer data between spreadsheet and data base files. 

To transfer data from a spreadsheet to a data base file, use the 
Open-Apple-C command to copy some spreadsheet rows to the 
clipboard. Press.Open-Apple-Escape and select Data Converter 
from the TimeOut menu. The data on the clipboard will instantly 
be converted into data base data. 

Create a new data base file or load one in from disk. Place the 
cursor where you would like to insert the spreadsheet data, press 
Open-Apple-C and select From clipboard. Each spreadsheet row 
will now be inserted into your data base file. Each column from the 
spreadsheet will become a data base category. 

To transfer from a data base file to a spreadsheet file, copy from 
the data base file to the clipboard, call up the TimeOut menu, 
select Data Converter, and copy from the clipboard to the 
spreadsheet file. Each category from the data base will become a 
spreadsheet column. 
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Help! 

Customer Support Information 

If you have questions or problems, you can contact the Beagle Bros 
Technical Support Staff for expert assistance. 

Before calling, check the instruction manual to see if it contains the 
information you need. Write down a complete description of the 
problem, the version number of the software, and the names and 
version numbers of any other AppleWorks enhancement programs 
you're using. 

If you have a modem, you may also receive Tech Support on our 24-
hour Customer Support System. The system provides an electronic 
mail and conferencing system, along with the latest information 
about product updates and changes. 

Technical Support: 
(619) 296-6400 8 am to 5 pm, weekdays (pacific time) 

Modem Tech Support: 
(619) 296-6490 24 hours, everyday 

Or, you can write to: 

Beagle Bros, Inc. 
6215 Ferris Square, Suite 100 
San Diego, CA 92121 
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BEAGLE BROS DISKS are carried by most Apple 
software stores. Or, if you live in the Boonies, buy directly from Beagle Bros by phone or mail. 

To order, phone 819-298-8400 (Mon-Fri, 9am-4pm Pacific Coast time) 

0 ALPHA PLOT Hi-Res Graphics Utility (includes Apple Tip Book #4) ......... $39.50 
0 BEAGLE BAG Twelve Apple Games on One Disk (a bargain these days!) ..... 29.50 
0 BEAGLE BASIC Applesoft Enhancer {req. 64K, includes Tip Book #6) ........ 34.95 
0 BEAGLE GRAPHICS 16-Color 560-wide Double Hi-Res Graphics (req.128K) ... 59.95 
O BIG U ProDOS File-Mover and Many More Utilities (req. 64K) ................. 34.95 
0 D CODE Applesoft Program Compactor and De-Bugger ..................... 39.95 
O DISKQUIK DOS 3.3 Disk Drive Emulator (requires 128K) .................... 29.50 
O DOS BOSS Disk Command Editor (includes Apple Tip Book #2) .............. 24.00 
O DOUBLE· TAKE Two-Way Scroll/Multiple Utility (includes Tip Chart #1) ....... 34.95 
0 EXTRA K Puts Your Extra 64K to Work! (requires 128K) ..................... 39.95 
0 FATCAT DOS 3.3/ProDOS Multiple-Disk Catalog and Filename Sorter ........ 34.95 
0 FLEX TYPE Flexible Hi-Res Text Utility ................................... 29.50 
D FONT MECHANIC 30 Hi-Res Fonts and Utilities for Shape Mechanic ......... 29.95 
0 FRAME-UP High-Speed Presentation Utility ............................... 29.50 
0 GPLE Global Program Line Editor (includes Apple Tip Book #7) .............. 49.95 
0 I. O. SILVER Hi-Res Action/Strategy Game ................................ 29.95 
O MACROWORKS AppleWorks Enhancement Disk .......................... 34.95 
0 MINIPIX DISK #1 200 Pictures on Disk for Print Shop and Other Programs ... 29.95 
0 PRO-BYTER ProDOS/DOS 3.3 Disk Zapper (includes Apple Tip Book #8) ..... 34.95 
0 PRONTO.DOS Triple-Speed DOS 3.3 I DOS-Move Utility ................... 29.50 
O SHAPE MECHANIC Hi-Res Shape Editor {includes Apple Tip Book #5) ...... 39.95 
0 SILICON SALAD 100+ Utilities (includes Command Chart) .................. 24.95 
0 TIP DISK#1 100 Tip Book Programs on Disk (includes Command Chart) ...... 20.00 
O TRIPLE-DUMP Picture-Printer Utility ..................................... 39.95 
0 UTILITY CITY 21 Useful DOS 3.3 Utilities (includes Tip Book #3) ............. 29.50 
0 .................................. __ 
o ______________ .................................. --

-ALL ORDERS SHIPPED IMMEDIATELY VIA FIRST CLASS MAIL-

YOUR NAME ________________________ _ 

ADDRESS __________________________ _ 

CITY, STATE, ZIP _____________________ _ 

Payment: 
o Personal Check or Money Order 
o COD (USA only) 
o School or Company Purchase Order 
o MasterCard or Visa (see below) 

SUBTOTAL . ... . .. . ... . ... . .. . ..... $ __ _ 
+6% if California . . . ....... . ...... . . 
+$3.00 if COD (USA only) . . ...... . . 
+Shipping ....... . ............... . 
Any siz9 ord9r: $1.50 for USA or Canada (1st Class) 
or $5.50 for Ov9rs9as (Air Mail) 

TOTAL ... . .. .. ..... .. . . ....... . ... $ __ _ 

Visa or MasterCard No. _______________ _ Exp. ____ _ 

Daytime Phone (in case of problem with order) ----------------

Signature----------------------------

Mail to: BEAGLE BROS, DEPT. F 
3990 OLD TOWN AVENUE, SUITE 102C 
SAN DIEGO, CALIFORNIA 92110 
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